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Learning Objectives
e (Get up-to-date information about the new features released
e Learn step by step how to use native CAD data in various formats with Fusion 360
e Learn step by step how to use the new copy features and what they can now do
e Learn step by step how to use new features such as enhanced project and admin
options
Description

You've taken the step with Fusion 360 software and Fusion Team to put your company on the
right path to total team collaboration. However, it's easy to fall into a routine and not get a
chance to see what the new features do or how you can incorporate them into your daily
workflow. Let us show you the new features and updates: Use CAD data from your native file
formats, updates to roles, and enhanced team and project administration are just a few of the
topics we'll discuss.

Speakers

Lisa Darrah is a senior program manager for Fusion 360 cloud-based products and services.
She has been at Autodesk, Inc., for 18 years. She started at Autodesk as a product support
engineer and then moved onto quality assurance and project management. Her knowledge of
the various aspects of software lifecycle has helped her as a program manager to include the
views from Autodesk customers while defining and driving the Fusion 360 cloud-based products
and services projects.

Jeremy Lambert has always had intrigue for technology and how it can help drive innovation
and better products. CAD, CAE, and CAM caught his interest early on and inevitably lead him
towards mechanical engineering. Following school, Jeremy gained product development
experience working for product manufacturers, including General Dynamics. Jeremy joined
Autodesk, Inc., in 2000 and is now a Senior Product Manager on the Fusion 360 product team.
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Exploring Fusion Team and Fusion 360

Fusion Team allows you to connect multiple teams and suppliers to share files securely across
departments and supply chains. Viewing models can be done instantly and the Live Review
functionality allows real time interaction with your designs. These are just some of the things
that Fusion Team does to expand on your Fusion 360 toolkit.

Coming Soon to a Hub near you
Currently, all Fusion 360 customers have a personal hub that you can access in Fusion 360. But

soon, you will be able to have access to Fusion Team hubs. This will be available in your profile
drop down.

Select your profile and select the Switch Hubs flyout.

E ]
The Create Team Hub option will be

3\ o~ available at the top of the list of hubs
available. After you select the option to

Autodesk Account create one, you V\_/iII_ be_directed_ toa
walkthrough providing information about
Preferences your hub and the benefits. Most of the
Switch Hubs » + Create Team Hub benefits will be detailed in this handout.
My Profie | v BankimC Note: You only need one Fusion
@ Sign Out | Team Hub. For those of you that are a

part of a company, please check with
your organization before creating a
team hub.

Figure 1:Profile dropdown in Fusion 360.

As you review this handout, most workflows are applicable to personal hubs as well. Workflows
that are not available in personal hubs will be noted in red

Accessing Fusion Team within Fusion 360
When you are working in Fusion 360 and have a design open, you can access your hub by
selecting the file dropdown from the menu bar and selecting Open Details on Web.
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New Design L

New Design From File

New Drawing »
New Drawing Template F
4+ BR Related Data »
A Open Details on Web

Save Cirl+5

Save as

Recover Documents (0

Export...

C
Live Review
Share »
3D Print
View »

Scripts and Add-Ins...
Fusion 380 App Store
Add-Ins (Legacy)...

Figure 2:File Menu dropdown in Fusion 360.

Your web browser will open and you will see the Fusion Team Viewer:

& C | @ Secure | https: Your Hub name URL *| =

Overview

File Overview
Ref s

Navigation Bar

View Relationships Edit in Fusion

View, Add and Reply to Comments

Share and Live Review
Download -

Copy, Move, and Delete ~

Viewing Tools Viewing Tools

Figure 3: Fusion Team Viewer.
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With Fusion 360 files, the Viewer page opens by default. Some of the fundamental areas of the
viewer are:

The Navigation Menu Bar- Left Side:

$ Home » Forklift CAT DP70 » Forklift CAT D...bly

Figure 4:Left Hand Side of navigation Menu bar in Fusion Team.

The top interactive navigation bar will allow you to see where you are within your hub. You can
always select the Fusion Icon or Home to go to the main hub dashboard. The Version (V.(#))
drop down will allow you to view a different version or promote a version.

The Navigation Menu Bar- Right Side.
Overview S m < 4+ ~ @

Figure 5:Right Hand Side of navigation Menu bar in Fusion Team.

On the right side of the navigation menu bar you have the following options:

Overview

Overview

The overview button will open the overview page. This page provides
several types of information about the file like:

e Name

e Version
o Type

e Sijze

Last update and time

Name of person who uploaded it

Design References
Related Data

Comments
Share Link Status
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R2D2 - Full Assembly v+

FusionDesign | Shan COMMENTS

Design References

oWl vl e

Related Data

e M &8 F 6

Figure 6: Overview Page of a Fusion Design file.

If you look around on the Overview page, for Fusion files, you can find out information about
where the file is used, what drawings are available in the Design References area. Also, any
other data like Renderings will be shown below in the Related Data area. To return to the
Viewer, just select the View button in the top right-hand corner.

Edit

For Fusion 360 files, you will have two options to edit files. Edit in Browser or Edit on
Desktop.

Figure 7:Right Hand Side of navigation Menu bar in Fusion Team with Edit Menu expanded.
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Comment

The Comment feature allows you to make, view and respond to comments about the
design.

Overview

COMMENTS

Add a new comment

Post Cancel

o g Rajiv Shivane

Wonder if we got the material right

° g Rajiv Shivane

Rahul Bhandarkar Can you confirm the material

specs

I

Figure 8:Comment feed expanded

This option is also available in the Overview page. Once you select the option to add a
comment, a snapshot of the view you are currently seeing will appear in the comment feed.
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Sharing

The Sharing feature will allow you to share your data in many ways. When you select
the sharing icon, you will see an option to Share and Live Review.

Share

For sharing, there are three options. You have Share a link to the
file, email a link and embed the view in something like a wiki or a
web page. When you select the Share option, by default, the

download option is on for shared links. If you do not want your “ha |
stakeholder or collaborator to download the files, make sure you ) -

m

turn this off. Live Revie
When you no longer want to share the file, you can turn this off by Figure 9:Sharing Menu
toggling the share option to off. dropdown options

Share
Share

Copy Link Ema Embed

Share this item with anyone using the following link

| N o

Privacy Settings
Sharing is on by default, turn

o allow viewers to download to their computer this off if you do not want to
T o o allow downloads of the shared

file

Turn this on if you want to have a password on the shared file

]
D

Figure 10: Sharing Dialog options

This can also be done in the file Overview, you will see the status of your shared file at the top
of the page. You can just toggle off selecting the on/off status.
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R2D2 - Full Assembly vz~

Fusion Design | Shared Link

Figure 11: File Overview Shared link toggle

Sharing Live Review

Live review is a feature that allows you to interactively collaborate with your project members
and stakeholders to review a design or model. When you select the Live Review option, a new
web tab will open that is dedicated to the Live Review session. Within the browser window, the
Live Review information for your file is available. Add participants by sending them the link.
Once the session is started, you can select the comments panel to interactively review the file
and collaborate on the design. The list of participants will also appear who are active in the Live
Review.

See Comments of the Live Review Session

Invite People

Share this link te invite others @

tps://myhub.autodesk360.co Copy

Participants in the Live Review appear here

Figure 12: Active Live Review Session

Once you have completed the session, just select the End option in the top upper right-hand
corner and the session will end. Close the browser window and return to Fusion Team.
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Download

2 /s ®m < 4
The Download option will display a dropdown with various
options for downloading the file. The file formats that appear will be Fusion 360 Archive
based off the type of file that is open in the viewer. In the example -
shown in the Download Menu dropdown, with the Fusion 360 file, nuEnter 2
these are the options to download a Fusion file. GES

Figure 13: Download
Menu dropdown

Copy, Move, Delete

W

There are 3 options for your data. Project members can Copy,
Move, and Delete files from one project to another project they are part
of. This is available in the dropdown menu next to download. When

you copy a file or folder from one project to another, a copy is made in ]
the project you are copying to. However, comments are not copied. -UR)

When you move a file or folder from one project to another, the content Mowve
is moved along with associated comments into the new project. The
content will no longer be available in the original project.

i
(1]
[

(]

Figure 14: Operations
Dropdown Menu
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Viewing Tools

At the bottom of the viewer, there are many tools available
while in the viewer. This set of tools in order from left to right are:

e Orbit: There is Orbit and Free orbit when you select the option arrow
e Pan: Pan allows you to pan around the view
e Camera: Four options for Camera are: Roll, focal length, Fit to View, and Home.

e Zoom: The scroll zoom or zoom to window are the 2 options in this command

Markup Tools

Next to the Viewing tools, you have the Markup Tools. This set of
tools in order from left to right are:

e Markup: When you select Markup, the viewer will enter the Markup Mode and remains
so until you save a markup or cancel. A markup is saved as a comment and it will
include a snapshot of your viewpoint to give others the exact context in which you
marked up the design.

e Comment: There are two options in Comment, you have Comment on a point, or on an
object an allows you to pan around the view

e Hide All Markers: This option allows you to hide all the markers that may be visible in
your design.

Examine Designs
'3
-
v &
Next to the Markup Tools, you have Examine Designs. This set of tools in
order from left to right are:

e Explode: When you select explode, the viewer will allow you to interactively select your
explosion factor with a slide bar above the toolbar

e Section Analysis: There are four options here. Add a box and add a plane for X, Y, or Z
for your section analysis
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Viewing Tools: Settings

- E & M

Finally you have the Settings and miscellanous options. This
set of tools in order from left to right are:

e Print: Print the design

e Properties: Click to view properties of a selected part within your design.
e Print: Print the design

e Settings: Click to customize your viewing settings.

e Full Screen: Click to change Viewer to full screen view and click Allow. Press Esc or
click the Full Screen toggle option to exit Full Screen view.

Fusion Team Project Page
Now that you have viewed the data in your project, Fusion Team has a project page where you
can view all the projects that are in Fusion Team that you are a member of.

t Team AU Demo = Team Hub Name

PINNED | ALL | OWNED BY ME | SHARED WITHME | ARCHIVED Create Project Activity
Name Outer Ankle
Lisa Darrah uplcadad to
Admin Project Nov 24, 2015 " o Jan 25th et
P 1 hour ago
& 17 -
=
'.ﬂ‘ Audobon Paul sanderson Nov 30, 2015
R2D2 - Full Assembly
Lisa Darrah uplcadad to
\/ Church Renovation Rahul Bhandarkar Feb 25, 2016 - Uﬁ DE?S
) our ago
» 'y
‘ Demo Project Nov 24, 2015 Centre Leg
Lisa Darrah uploaded ta
3 Lisa Demo
Ember - 3D Printer Fusion Nov 24, 2015 ﬂ‘{“ 1 heurzgo q
G

Figure 15: Fusion Team Project Page

Near the top of the project page, you have Project filters that will filter out the view to either
pinned projects, Projects Owned by you, Projects Shared with me, and Archived projects. Next
to the filters, there is a Create Project option to create new projects in Fusion Team. Finally,
there is an Activity feed to display all the activity in your Hub.
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Admin Overview *Team Hubs Only*
As an admin of a Team Hub, there are many options to customize the hubs. To access the
Admin settings, go to the profile drop down and look for Admin.

Lisa Darrah

Figure 16: Profile Drop Down with Admin option

Once selected, the Admin page defaults to Team Hub settings. The other options are Members
and Roles, Projects, and Subscription.

Team Hub Settings Members And Roles Projects Subscriptions

Team Hub Name

Project Contributor Access

Allow Project Contributors: Yes

@ Click Edit to change Project Contributor sccess

Team Member Invite Mode

Current Mode: Admin Approval Required
@ Click Edit to change Invite Mode.

Figure 17: Admin page of a Team Hub
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Team Hub Name:
Changing the Team Hub Name by selecting edit and then save.

Team Hub Name

AU Demd| ‘

mo.zutodesk360.com

Figure 18: Edit Team Hub Name field

Project Contributor Access:

Project Contributor access is allowed on team hubs by default. Determine at the outset if you
do not want to allow Project Contributor access. If access is turned off after users have joined
as Project Contributors, they will lose access to their projects. If access is re-enabled however,
they will regain access to the projects.

Note! Should | allow Project Contributors on the Team Hub?
Consider the following questions
¢ Do you want to invite external collaborators like customers, vendors, or design partners
to your projects?
¢ Do you want to restrict the number of users who create projects on the hub?

If your answer is Yes to any of these, you want to allow Project Contributors.
To change Project Contributor access

1. On the Administrator Console, select Team Hub Settings > Edit in the Project Contributor
Access section.

2. Click the Toggle switch for Allow Project Contributors > Save.
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Project Contributor Access

C Allow Project Contributors

Select to allow Project Contributors on this Team hub. If you disable Project Contributor access, existing Project Contributors will no longer be able to access

projects.

Cancel Save

Figure 19:Project Contributor Access option

Team Member Invite Mode:

Team Members can always be invited by Team Administrators, regardless of the setting
selected here. The following settings determine whether Team Members may be invited by
Team Members.

e By Team Administrators only

¢ By Team Members but subject to approval by a Team Administrator or directly by Team
Administrators + auto-approve users from a specific domain

e By Team Members and Team Administrators
The default setting for Team Member Invite Mode is set to Admin Approval Required.

Team Member Invite Mode

How do you want new Team Members to be invited to this hub? Select an option below.

Admin Invite Only

@ Hub Administrators must add new Team Members from the Admin console.

e Admin Approval Required

@ Team Members can invite. Hub Administrator must approve membership of all new Team Members.

Automatically approve email-ids for these domains

© Enter domains separated by commas. Example: companyname.com, companyname2.com

No Admin Approval Required

@ Team Members can invite. Anyone who signs up becomes a Team Member.

Cancel Save

Figure 20: Team Member Invite Mode options

Once the selection of options are on the preferred setting, select save to confirm the changes.
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Admin Main Page Overview: Members and Roles
On the Members and Roles tab, there is the People tab, Pending Invitations and Sent
Invitations.

Members and Roles

PEOPLE PENDING INVITATIONS | SENT INVITATIONS

Name Status Joined On Last Activity Role
Anil Cpdmaws3 ACTIVE Oct 10, 2016 Oct 10,2016
anil.cpdmaws3@hotmail.com
G Craig Godfrey ACTIVE Oct 18, 2016 Oct 18, 2016
!
1‘ Lisa Darrah ACTIVE Oct 10, 2016 Oct 19, 2016 Team Administrator
lisa.darrah@autodesk.com

Figure 21: Members and Roles options

People Tab
The Hub members and their status, when they joined, their last activity and their Role are listed.
Changing the role of a member can be done by selecting a member, and select the drop down.

Name Status Joined On Last Activity Role

Anil Cpdmaws3 ACTIVE Oct 10, 2016 Oct 10, 2016
anil.cpdmaws3@hotmail.com
Team Administrator

Project Contributor

A Craig Godfrey ACTIVE Oct 18, 2016 Oct 18, 2016

Figure 22:Team Member Role Options

Now the options to change the role from Team Member, to Team Administrator to Project
Contributor are visible for selection. There is also an option to deactivate a user.

Pending Invitations
In the Pending Invitations tab, this is where invitations that are pending admin approval will be
displayed.
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Members and Roles

PEOPLE = PENDING INVITATIONS  SENT INVITATIONS

Name Senton Sent by Status
Lisa 1 minute ago John Darrah INVITED >
‘ Reject ‘ ‘ Approve

Figure 23: Pending Invitations tab

Here the option to reject or approve the invite is available.

Sent Invitations
This is like the pending invitations, but the option to resend the invitation or withdraw it is
available.

Note! Why Should | have more than one Admin?
Consider having more than one admin on your site so that you can have someone else that can
approve and administer the hub because of:
o Time off: People take time off for vacations, personal or medical time and a backup
admin is needed.
¢ Change of ownership: In the instance that someone leaves the company, having a
backup admin will ensure that the day to day business is not impacted.

Members and Roles

PEOPLE ~ PENDING INVITATIONS ~ SENT INVITATIONS

Name Senton Sent by Status

Lisa 39 minutes ago John Darrah INVITED >

Resend Invite ‘ ‘ Withdraw

Figure 24:Sent Invitations tab

Page 16



/\ AUTODESK
UNIVERSITY

Team Hub Roles at a glance

Team Administrators Team Members Project Contributor

Project Creation v v

Browse and Join Projects v v

Invite Team Members 7 * *
* Requires Team Admin Approval

Invite Project Contributor v v

Can Upload Files v v v
Can SEE other Members 7 v

Can Approve Invitations from other v o7

contributors

Can approve and share public links v v

Right to assign hub-level roles to users v

Can purchase seats v

Admin Main Page Overview: Projects

Team Administrators can manage projects and project members in the following ways. They
can:

o View projects and project information

o Filter projects based on status

o Transfer, archive, and restore projects
o Delete archived projects

o Change a user's role within a project
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= f‘ AUTODESK FUSION | AULD2016-Data

Team Hub Settings Members And Roles Projects Subscriptions
Projects
Show: All v O\
Name Type Created by Created on Status
Admin Project Secret A360 Oct 10, 2016 ACTIVE v
C-3PO Closed Craig Godfrey 4 hours ago ACTIVE >
2 project members
Archive ‘ ’ Manage Roles ‘ I Transfer ‘
Demo Project Open A360 Oct 10, 2016 ACTIVE v

Figure 25:Project Options tab

Archive and Restore Projects

Team Administrators can archive and restore projects from the Projects tab in the
Administrator Console. The Administrator can also filter projects to see all archived projects.
Archiving a project means:

* Project members can no longer access this project.

» Existing content in the project will no longer be accessible to project members,
including the admin.

* No additional content/activity can be added to the project.

* The project and its content will no longer appear in search results or in the Projects

list.
. : L . Pl v
After archiving a project, an Admin will still be able to view the
archived projects and restore them by selecting the option in the
Show Filter drop down. All
Active
To archive a project, select the project on the Project tab > Archive
> Archive. Archived

To restore a project, select the project on the Project tab > Restore.  Figure 26:Archive options
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Manage Project Roles
Within a project, there are three roles: Project Administrator, Editor, and Viewer. The person
who creates the project is the default Project Administrator. Everyone in a project is a project
member. The project role of a user determines the following:

o Level of access to project data

e Actions they can take on data
e Right to invite project members and change their roles

Project member roles are visible to all members of a project and the Project Members Project
role can be specified at the time of inviting a user to a project. Only a Project Administrator can
change the role of project members.

Manage Roles | Luke X

Project Members

Show: A v Q
NAME AND EMAIL TITLE ROLE 9
A Lisa Darrah _ _ dri
- o Senior Program Manager -...  Project Admin
John Darrah
Viewer ~ L1
Editor

Project Admin

Figure 27: Project Member Roles Dialog

Only a Project Administrator can change the role of project members.
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Admin Main Page Overview: Project Access
Roles

Viewer Editor Project Admin

View
Files(online), folders, comments (view and post) and people \/ /

<

Discussions & Calendar
Access to conversations and events ‘/

N

Get Link and Live Review
Get link for shared files and initiate live review

Edit, Upload, Download

Copy, move, rename, and delete files/folder

Manage Sharing

Enable and set public sharing, invite others to the project

B < . <

< B

Project Admin
Project settings, approve people in the project, set access levels

Transfer Projects

Team Administrators can transfer projects across hubs provided they are Team Members on
the hub that they are transferring the project to. Team Administrators who are not members of at
least one other Team hub will not see the Transfer option.

To transfer a project:
1. Select the project > Transfer.

2. Select the Team hub that you want to transfer the project to > OK.
Note! When would | need to transfer a project?

If your organization has purchased a new hub subscription and requires projects to be
moved to that hub, you will need to transfer projects.

Note! What should | do to ensure that my project is transferred successfully?

Make sure the destination hub has the same Project Contributor and Team Member Invite
settings as the source hub.
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Cross Project References *Team Hubs Only*

Now data or reference data can be reused from separate projects without requiring copies of the
data. The options, Insert, Move, Copy and Save as are available to utilize existing data within
the projects.

Note! When doing any type of Cross Project Reference activity, any option performed on the
data requires membership in the projects where that data will be inserted, moved, copied or
saved to.

P Head

o Cpen

Insert into Current Design
@ MirrorOuter Ank o Drawing from Design

¢ P 1 Start Live Review
Share Public Link

. Import Mew Versian
P MirrorQuter Leg P

jl j 0 Rename
.Jﬁ | - Move
Copy
. @ Outer Ankle Delete
:,-f*f?) 11/917 Add to Offline Cache

Figure 28:These three options on the right click menu are part of the new Cross Project References functionality

Insert into Current Design

Data from any project can be inserted in a design in a different project. Simply right click on the
file and select Insert into Current Design. Once inserted the ‘Linked’ Indicator will appear next to
the component in the component tree.

T ®  wrrorouirane v |

Figure 29: Linked indicator next to inserted component

Move

Data from any project can be moved from a current project into a different project. Simply right
click on the file and select Move. This helps to structure data in component libraries after the
design or during design to help reuse data in the future

Copy
Data from any project can be Copied from a current project into a different project. Simply right

click on the file and select Copy. Utilizing the copy feature allows preservation of the original
data while revising the new copy for concept designs, or new designs.
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SaveAs

Data from any project can be Saved As a new Fusion Design into a different project. From the
File menu dropdown, select Save As. Type in the new file name, then select the location of the
project to safe the file to.

Save As X
Mame:

Head w1
Location:

AU DEMO TEST PROJECT 3 O master b
— —— —

Using the drop down, you can save the design to a new project.

Figure 30:Save As Dialog options

Requesting Access to Cross Project Data

There can be instances where one of the team members is not a part of a project where data is
referenced. This will not be an issue because if a team member tries to access data across
project that they are not a member of, they will get notified that they need to request access and
a notification will be sent to the Project Administrator requesting access for that team member.

AnyCAD *Team Hubs Only* Preview

This new feature allows interoperability between Fusion 360 and Inventor™ and Fusion Team.
Now desktop, cloud and browser can have one data source for your entire project. Also,
AnyCAD provides the ability to reference almost any CAD data, like Solidworks™ data into
Inventor and Fusion 360 while maintaining full file associativity without translation.

Note! Using the AnyCAD functionality, you will need a Fusion Team hub, Desktop Connector,
along with Fusion 360.

Getting your CAD data in the Cloud.
Once you log into your Fusion Team Hub, in your profile settings you will see an option to
download “Desktop Connector for Fusion”
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Lisa Darrah

My Account | Seftings

Signed into

* Team One Fusion Share

& Desktop Connector for Fusion

‘ Sign Out

Figure 31:Profile Dropdown with Desktop Connector Install option

Once the Desktop Connector for Fusion is installed, the cloud drives will be displayed in the file
explorer. These cloud drives will act like any drive in file explorer. Expand the drive and the
Team Hubs you are a member or owner of will be displayed. Selecting the Hub will display the
projects as folders. Then CAD or any files can be dragged and dropped into the folders, starting

the upload into the Fusion Team.

Documents
; Downloads

v [F Fusion 360 W= Cloud Drive

42 ADSK Fusion

v ¥ AUDemo 4 === Team Hubs

_Medical Center
Admin Project

AU DEMO TEST PROJECT

Audobeon

Demo Project
Ernber - 3D Printer
Epcot Airport

Lisa Dermno

Mc Cormik-D326
PM122738 AL20TT

Projects in Team Hub
Member of Project
Owner of Project

Figure 32: Desktop Connector dialog
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Once the CAD files have been uploaded into the cloud drive, they will be visible in Fusion Team
in the project they were uploaded into. The will also appear in Fusion 360 in the data panel.
Now, the CAD data can be inserted into a fusion design and keep the reference.

Using your CAD data in Fusion 360

While in Fusion 360, have the Fusion Design open and in the data panel, select the part file to
insert into the design.

=3 Motor Hat.ipt

-
- Open

Insert into Current Design

ki Motor Hat Bushing.i ~Creaie Fusion Design
. Share Public Link

Rename

=3 Motor Housing.ipt

Figure 33:Insert into Current Design

Once the .ipt is inserted into the Fusion design, it still retains it reference to Inventor allowing
design data to retain its format without the need of translating it into Fusion 360. Any
modifications to the file that are done in the CAD software will be reflected in Fusion 360 after
the file is saved. The Component out of date message is displayed along with the alert indicator.
Once the component is updated the changes done in the CAD software will be reflected in the
Fusion Design.

D & () MotorHat:1
D @ () MotorHat Bushing:1

D D A Motor Housing.ipt v1:1

Figure 34:Update needed on .ipt file
Files are identified by a ‘Linked’ indicator in the component tree easily indicating which

> ﬁ' D 69 Motor Housing.ipt w5:1
components are linked. If desired, this link can be
broken.

References for Help
If additional support is needed, please check out our customer forums. Here are some links to

Fusion 360 Customer Forum

Fusion Team
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https://forums.autodesk.com/t5/fusion-360/ct-p/1234
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